Creating problem files for the Andes Workbench

This describes how to use the workbench authoring interface to create the “.fbd” problem files needed to show problems in the Andes workbench.

Setting up

Author privileges

To enable access to the authoring interface, your Andes installation must be configured with “authoring privileges”. This is controlled by a setting in the system registry. To turn this on, copy the following text into a file on your desktop and name the file with a .reg extension, for example, “Author.reg”.

REGEDIT4

[HKEY_CURRENT_USER\Software\Andes Group\FBD\Settings]

"Author"=dword:00000001

This file is now a “registry script”. Double click file “Author.reg”. Windows will ask permission then automatically make the necessary setting in the registry. 

Alternatively you can make this setting manually by running the registry editor: type either “regedt32”  (on Windows XP/2000/NT) or “regedit” (on Windows 95/98/Me) into the “Run” box on the start menu. Find the key (folder) HKEY_CURRENT_USER\Software\Andes Group\FBD\Settings and then edit or create the named DWORD value “Author”, setting it to 1. Note Microsoft recommends caution when editing the registry because some information essential to booting is stored in the registry.

This setting must be made before starting the workbench for authoring. It will affect all versions of the workbench installed on your system.

If you want to turn this setting off, change the 1 to a 0 in the above instructions.

Development directory

Most likely you will already have the last public Andes distribution installed somewhere on your system, probably in C:\Program Files\Andes. Call this your Andes installation directory. This directory should remain entirely unaffected while doing any development work. While developing problems, you will instead be working out of the directory  C:\Andes2, which we will call the “development directory”. The development directory should be set up to include all the necessary files to run Andes. To do this, copy any needed files from the root of your Andes installation directory into C:\Andes2. It should have the following (not all of these are  needed to create problems,  but they won’t hurt either):

acl5016.dll

Allegro 5.0.1 runtime library

andes2.dxl

Andes2 help system Lisp image (made with Acl501)

Andes2.exe

Lisp driver program to run helpsystem (from Acl501)

config.cl

Help system config file

fbd.cnt


Workbench help file table of contents

fbd-tcp.exe

Workbench executable

fbd-tcp.hlp

Workbench help file

Setup.exe

Andes2 setup program

solver.dll

solver library

upload.exe

upload utility

Your development directory should also have the following folders:


Problems

Contains a .prb and .fbd file for each problem, and an .aps files for each problem set


Review


Contains equation review pages and minilesson files


Log


will hold log files

You can copy these subdirectories from your existing Andes installation as well, in order to have all existing problems and problem sets in Andes. Be careful not to overwrite any problem files that you are developing.

For each problem in Andes there needs to be a .prb file for use by the help system – this file can be created by the sgg – as well as a .fbd file used by the workbench.

These two different Andes directories can co-exist on your system, because the Andes system is designed to find all files it needs relative to the directory in which it was started. So, when you launch the workbench in C:\Andes2, it looks for problem files in C:\Andes2\Problems. To avoid confusion, however, you need to be clear which one you are running at any time. We recommend creating a shortcut on your desktop to the workbench executable “C:\Andes2\fbd-tcp.exe” and giving it a label like “Development Workbench”, so that you can distinguish it from the version in the Andes installation directory. While creating and testing, launch from the “Development Workbench” shortcut. 

Remember that if you run the Andes shortcut on your Start Menu you will lauch the version installed in C:\Program Files\Andes. This won’t contain new problems under development.

The development directory should always have the latest version of the Andes files. Possibly it will have versions of the Andes executables that are newer than the last released versions.

Creating a new workbench problem file

1. Launch your development workbench

2. Hit Cancel to dismiss the window for choosing a problem set.

3. One the View menu, select Author Mode to put the workbench into “Author Mode”. The author toolbar should appear, though all buttons are grayed. 

4. On the File menu, select New

5. choose Problem, and hit OK. An empty problem should appear.

Problem properties:

Double-click anywhere in the diagram pane to bring up the property dialog for the problem. Enter information as follows:

General 
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For the Problem Name, enter the problem id as used by the help system, for example: Exdt11a or Excir12b . (Case doesn’t matter in the problem id).

In the features box in the problem type: click to highlight all features that should be enabled in this problem. Scroll the box to see more of them. These features will control which tools and variables are enabled when the problem is run. 

· Most mechanics problems use “Kinematics” and “Force” tools and variables, but I think you can disable Force for kinematics-only problems.

· If any rotational vectors in the z-axis are used, check “Rotational Kinematics”. 

· “Gravitation” should be checked for large-scale gravitation problems only -- it changes the “Weight” force choice to “Gravitational”.

· “Circular Motion” enables the radius drawing tool. (It also enabled the z-axis since some of our circular motion problems use it.)

· “Vector Arithmetic” enables the coarse grid for vector drawing by counting grid boxes. It may not be needed on all vector problems.

Other items on this page are obsolete in Andes2 and can be left with defaults.

Objects
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List the bodies in the problem, a convenient way is one to a line. This should include all kinematic objects, plus any force agents. 

For Circuits problems: the objects should list names of all circuit components.

The names should match the ids used in the formal problem specification (case does not matter), with the following possible exception:  kb body ids used in the formal problem specification can’t contain hyphens (since they look like minus signs when embedded in variable names). However, hyphens can be used in the workbench object names if desired. Any hyphen in an object name will be translated into an underscore before processing. Thus, you can display F-14 on the workbench  as long as you use F_14 in the formal problem definition.

Times
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List the problem times in the form shown. For time points, give explanatory text after the = sign. List all intervals you wish shown as choices.

Note: workbench times should always start with T0, while the problem spec has times as integers beginining with 1.

Branches (circuits only)
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List the names of branches as they appear in the formal problem statement. This need only be filled in for circuits problems.

Positions (circuits only)
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This list was intended for use in mechanics problems for relative position vectors, but is not currently used for that. It is only used in circuits problems to list named points for the purpose of defining current through a point. Note that this example shows a problem where the points are named simply “A”, “B”, and “C”, but most of our circuits in fact use point names of the form “PtA”, “PtB”.

Problem Statement

The problem statement is created as one or more text pieces using the workbench graphics editor.  To create a text piece, click the text tool button – the one with an “A” on it – on the authoring toolbar. Type the text into the dialog box. You may wish to cut and paste the text into this box from another document in which you have the problem statement.  Note this text box will not automatically wrap long lines – you must break up lines yourself to lay it out in a reasonable way. The width of the box should be approximately the width of the longest line. Blank lines may also be included.

When you hit OK, the text piece will be placed at the upper left corner of the diagram pane. You can click on it to drag the text piece around on the screen to position it where you like.

To change a text piece again, double-click on it to return to the text dialog box. As with all graphics objects, select it and hit Delete to remove it.

It can be convenient to create the problem statement out of multiple text pieces, one for each part of a multi-part problem. This also makes it easy to leave room for answer boxes in between the parts. Then you can arrange the text pieces on the screen to make best use of space. Alternatively, you can type the entire problem text in one large piece. In this case you may want to include blank lines to leave room for answer boxes if these are to be interleaved with the problem statement.

Answer Boxes

To indicate where an answer box should go, you need to lay down a rectangle with a special identifier to mark the place where an answer box should be displayed. Click the rectangle tool on the author toolbar. Click and drag to create a rectangle where you want the answer box to go. You can click on this rectangle to select it, drag the handles to resize it, or click elsewhere on it to drag it to the right position on the screen.

Initially the rectangle is filled with grey to help you see it on the screen. Double-click the rectangle to bring up its properties dialog 
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In the “Fill” box, check “none”. Click the Author tab:
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Change the item ID field to have the form Answer-N as shown above, where N is the number of the question part starting with 1, thus Answer-1, Answer-2, Answer-3 etc. The numbering of answers should match the order of soughts in the problem statement. (This specially formed ID is what distinguishes a rectangle as an answer box marker in the workbench.)

To put a label near an answer box, you just use the text tool to add text pieces as for the problem statement. Many of our problems just say “Answer: ” before the answer boxes, but a few indicate which of two possible soughts is required, e.g. “x component: ”, “y component :”.

Diagram

Diagrams can be created in two ways, either by importing a graphic drawn with some other program, or drawing it directly using the rudimentary workbench graphics editor.

Importing graphics from a file

On the Edit Menu, select “Insert New Object”. In the Insert Object dialog, check “Create from File” and browse to find the graphic file you want to import. The graphic will be pasted into the workbench at the top left. Click on it to move it into the desired position. Use the resize handles to scale it.

The workbench can import bitmap (.bmp, .dib) and windows metafile graphics (.wmf, .emf) and possibly some other formats. Bitmap graphics are generally very large, although they can be reduced in size by taking care not to use more bits per pixel than necessary (for example, to save as a monochrome bitmap if color is not needed). Windows metafiles are coded lists of Windows graphics drawing commands and so are usually very concise files.

Importing graphics via the clipboard

In addition, you might be able to create a graphic in some other program such as Microsoft Word (use Edit/Insert/Picture/New Drawing) then copy the whole graphic to the clipboard, and paste it into the workbench using the workbench’s “Edit/Paste” command. Depending on the source program, the graphic may get converted into the metafile format even if the program does not explicitly offer you the option of creating a .wmf or .emf file.  Drawing graphics using the picture editor in Microsoft Word is possible this way. This picture editor is much better than the one in the workbench, so may be easier to use.

Note any graphic imported is copied into the .fbd file. Therefore, if you change the source graphic file, the workbench .fbd file is not automatically changed.

Inserting clip art

You can also use the workbench’s Edit/Insert New Object and then selecting Create New to run some program in place to edit the graphic, if the program supports OLE In-place editing. The choices available depend on what programs are installed on your system. The end user need not have the program used. In the past, a Clip Art collection was made available through Microsoft Office to insert some pieces of clip art, and these pieces have been useful for some of our problems.

Drawing in the workbench

The workbench graphics editor is primitive but has been used, together with some clip art, for most of our problems. It offers the following drawing commands:

Rectangle, Rounded rectangle, Oval,  Straight Line, Arc. These are all used by clicking, holding, and dragging a bounding box.

Polygon: click repeatedly to lay down successive points of a closed polygon. On the last point, double-click to indicate it is the last one.

Spline: click repeatedly to lay down control points. Double-click on the last control point of the spline. Must have an even number of control points. Drag the control points to shape the curve.

Properties: Double click on an object to open its properties dialog. This can be used to adjust line width and color (or dotted/solid), fill, and fill color on the objects:

Multiple Selection: Hold the control key while selecting to add to a selection. In this way multiple objects may be selected and moved as a unit. You can also drag the selection rectangle over many objects to select any object it touches.

Grouping: when multiple objects are selected you can use the Group command (Ctrl-G), or Diagram/Group, or Right Button Menu/Group to group the objects into a unit. Use the Ungroup command to break up a group.

Duplicate: Hit Edit/Duplicate or Right Button Menu/Duplicate to create a duplicate of the selected object or objects. You can also copy an object to the clipboard and paste it in again.

Front-Back ordering: Use Edit/Move Forward on a selected object to move it up one layer in the front-to-back ordering, or Move To Front to move it back. Similarly for moving an object back one layer or to the bottom. Note keyboard shortcuts for this as well.

Tips on the workbench graphics editor:

· If you need an arrow, draw one of the vectors and leave it unlabelled. In authoring mode the vector drawn does not count as a vector entry but is used only for its graphic.

· If you need a plane at a certain angle, draw a vector first and set its direction property to the relevant angle. Then draw the plane to align with the vector. Then delete the vector.

· Lines can be difficult to draw exactly vertically or horizontally when the grid alignment is on. You can turn the grid off on the View menu.

· If many objects are on the page, it can sometimes be difficult to select the one you want. In particular the bounding box of one object or group may make it difficult to select an object behind it. You may have to move it out of the way or adjust the back-to-front layering to select the object.

· Alas, there is no undo feature.

Copying graphics from other workbench problems: in author mode, you can open multiple problems at once. To switch between them, hit the inner restore box in the upper right of the workbench to keep the current document window from filling the workbench frame. With this you can have two windows open within the frame. You can then copy and paste workbench graphics from one problem into another, if you want.

Editing an existing problem

When you open an existing problem normally in the workbench, the workbench actually creates a new file (call it a solution file) for you to edit. The solution file contains a copy of the “master” problem file for the problem you selected. Although you are free to enter author mode in this situation, if you make any changes, you will only modify the solution file and not update the master problem file. So this is generally not a useful thing to do (unless perhaps you simply want to inspect the problem properties of the problem you are working on.)

To edit the master problem file, first make sure you have dismissed the Problem Set selection window and closed any problem set window (this is necessary to avoid a bug when moving in and out of author mode if a problem set window is open). Then enter Author Mode. Then select File/Open Individual Problem/ and enter the file name of the .fbd file you want to modify. Then edit the file as above and save your changes to the problem. Exit author mode before testing the modified problem.

Note that Andes problem files are normally tagged with the “read-only” bit in the Andes distributions. If you copy problem files from the Andes installation directory, they may have the read-only bit set. This can be used as protection against inadvertent overwriting, since the workbench will not overwrite a problem with the read-only bit set. If this happens, remove the bit using the file properties box in Windows shell. (You can use this remove it on multiple files at once).

Creating/Editing a problem set

Problem set lists are stored in .aps files in the problem directory. If you want to add a file to an existing problem set, open the workbench and enter author mode as above.

Select File/Edit Problem Set and select the problem set to edit. You will see the problem set contents as follows:
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Only the left-half of this display is functional. The right-half is merely prototype for facilities that have never been implemented (it was intended to set optional features for the problem set.)

Hit the Add button to select a new problem to add a new problem to the list, and use the Up or Down button to adjust the order of the list. Hit Save to update the .aps file.

Note that problem set files are just lists of references to problems and do not contain the problems themselves, like an assignment sheet.

To create a new Problem Set: In author mode, select File/New and then select Problem Set (edit mode), then add problems as above.

